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E:  Atomic Absorption Spectroscopy 
 

1.  List of Experiments 
1. Sodium in Drinks by Atomic Emission 
2. Calcium–Magnesium Water Hardness 

 
2.  Locker Inventory 
Glassware for each experiment may be found in designated drawers in room LM6.  These should 
include the following items; please report any missing or broken items to your lab TA or the lab 
coordinator. 
 

✔ Quantity Item (4 drawers for each experiment) 
 6 100 mL glass beakers 
 10 100 mL plastic beakers 
 1 10 mL graduated cylinder 
 1 25 mL graduated cylinder 
 2 50 mL volumetric flasks with stoppers 
 1 250 mL volumetric flasks with stoppers 
 13 100 mL volumetric flask with stopper 
 2 ea. 1, 2, 4, and 5 mL transfer pipettes 
 4 10 mL transfer pipettes 
 1 1.000 mL graduate (Mohr) pipette, in 1/100th units 
 20 Pasteur pipettes with bulbs 
 2 3-Way bulb pipette fillers 
 14 100 mL polyethylene storage bottles 
 1 250 mL polyethylene storage bottle 
 2 Wash bottles 
 2 ea. Glass rods and large spatulas (Scoopulas™) 
 1 Filter funnel 

 
In addition, you should have a mortar and pestle for experiment E1 
and two 20.00 mL transfer pipettes for experiment E2. 
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3.  Instrumentation 
During this set of experiments, you will be using one of two flame atomic absorption 
spectrometers: 

• Perkin-Elmer AAnalyst 100 spectrophotometer (software-controlled) 
• Perkin-Elmer AAnalyst 200 spectrophotometer (manual operation) 

Both spectrometers use double beam optics, laminar flow premix nebulizers, automatic 
wavelength and slit width selection, and automatic deuterium arc background correction.  One 
instrument can optionally be used with a model HGA-800 graphite furnace accessory and AS-72 
auto sampler, or a flow-injection hydride generation manifold for mercury determination. 
 
4.  General Operating Instructions 
The following pages provide general information on using the flame AA spectrophotometers in 
the Analest laboratory.  Please take time to read through these instructions carefully before coming 
to the laboratory.  You may also want to take a quick virtual tour of the instrument –see the 
course website for details.  Update: the software instructions refer to the AAnalyst 100 only.  
 

4.1 Starting the Instrument: 
 

(a) Turning the fuel gas on:  Make sure that the main valve on the acetylene cylinder in the 
prep room is on (open it by turning it counter-clockwise).  Both gauges on the regulator 
assembly should register pressure; the outlet (low-pressure) gauge should read at least 15 
psi.  You should not need to adjust the valve on the regulator (the large knob between 
the two gauges.) 

 
(b) There are additional single-stage regulator valves located in the gangway behind the 

instruments that runs between the benches.  Open the air and acetylene valves by turning 
them counter-clockwise about two turns.  You do not need the argon for these 
experiments, so leave the valve closed. 

 
(c) If the instrument is not already on, turn it on using the main switch at the bottom of the 

right-hand panel on the instrument.  For the AAnalyst 100 you will also need turn on the 
computer adjacent to the spectrometer.  Login to the network when prompted using the 
appropriate user name and password: 

 
AA #1: username: chm317aa1; password: aa1 
AA #2: username: chm317aa2; password: aa2 

 
(d) Once Windows has successfully started, double-click on the AA WinLab Analyst 

shortcut on the desktop.  A window titled Checking Connections should open, and 
should contain a box with a green check mark in it indicating that the computer and 
instrument are communicating with one another.   If the box does not show a green check 
mark, make sure that the AA is turned on.  Once all is correct (i.e. the green check-mark 
is displayed) click on the Exit button. 
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(e) On the splash-screen that appears immediately after dismissing the Checking 
Connections dialog, make sure that the Technique pull-down menu is set on Flame 
and then click on the Workspace button.  Select one of the following files in the 
resulting file dialog box: 

 
Experiment E1:  CHM317NA 
Experiment E2:  CHM317CM 

 
 This will ensure that the correct initial method is loaded for your experiment, and that 

the main windows you will require are open within the primary AAWinLab window. 
 

4.2 Configuring the Instrument via Software: 
 

(a) Maximise the main AAWinLab window and make sure that text beside the 
Technique... button is set to Flame (see illustration below).  The text beside the 
Method... button will indicate the initial method for your experiment, while the large 
box on the right should display the element to be determined.  These should be 

 
Experiment E1:  Sodium Emission Na 
Experiment E2:  Calcium Water  Ca 

 

 
AAWinlab Software Toolbar, showing the method for experiment E2 

 
 To switch to a different method, click on the Method... button in the toolbar, select the 

appropriate method experiment from the list in the resulting Open Method dialog, then 
click OK.  You can click on the Flame and Lamps icons in the toolbar to open the 
corresponding windows. 

 
è A lamp is only required for absorption measurements; you can skip the steps b) and 

c) for emission measurements, and proceed to d). 
 
b) Check which lamps are installed in the turret; if the lamp you need is not one 

manufactured by Perkin-Elmer, make a note of the current required to operate it – you 
will need this information later.  

 
(c) In the Align Lamps window, click on the Set Up button for the lamp you will be using 

in your experiment.  If the lamp you are using is not a Perkin-Elmer lamp, enter the 
required current from the label on the actual lamp.  The lamp will be turned on, selected, 
and aligned with the instrument’s optical path automatically.  Close the dialog window 
once this process has completed. 

 
(d) In the Flame Control window you will see an On/Off button and a Safety interlocks 

icon; this icon should show a green check mark.  If the box shows a red ‘X’ instead, there 
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is either insufficient fuel pressure to light the flame, the drain trap is empty, or the waste 
container on the drain is full.  Double-check the main acetylene cylinder in the prep room 
and the acetylene and air supply-line valves at the rear of the instrument.  If in doubt, ask 
the lab coordinator or technical staff for assistance. 

 
M Laboratory staff regularly optimize the burner height and fuel/oxidant flow rate 

before the lab.  Students should not attempt to perform this procedure on their own; 
it is included simply for information. 

 
 With the flame off, lower the burner assembly and, using a white card, check that the 

light beam and burner slot are aligned, raise the burner so that the light beam is just 
above the burner.  (A more precise adjustment can be made once the flame is lit, but is 
not necessary in these experiments.)  Once the burner is adjusted, close the Align 
Lamps window, and light the flame by clicking on the On/Off switch in the Flame 
Control window.  Aspirate deionised water into the flame. 

 
 Check that the flame is stable and a bright blue colour just above the burner slot.  If the 

flame is yellow and unstable, increase the ratio of oxidant-to-fuel.  Select Continuous 
Graphics from the Tools menu, and click on Autozero while aspirating deionised 
water.  Next, aspirate a standard solution of the test element (e.g. 5 ppm Ca) and note 
the absorbance values.  Select Characteristic Concentration from the Analyses 
menu, and enter the concentration and absorbance values for your standard solution.  
The calculator will tell you how close the results are to the characteristic value for this 
element. 

 
 If necessary, adjust the fuel, oxidant, or nebulizer flow rates and re-measure the standard 

solution.  The measured value should be within ± 10% of the characteristic value.  When 
satisfied that the instrument has been correctly optimised, close the Align Lamps 
window.  If you will not be performing measurements straight away, turn the flame off 
until you need it. 

 
4.3 Changing Methods and Lamps 

 
(a) There is a method for each part of each experiment.  To select one, click on the Method 

button in the toolbar and select the desired method from the Open Method window, 
then click OK.  If the new method requires a different lamp from the previous one, click 
on Lamps in the toolbar, then click on the Set Up button for the appropriate lamp in 
the Align Lamps window.  Check that the correct lamp is in the indicated turret position 
and, if it is not a Perkin-Elmer lamp, that you enter the correct operating current. 

 
4.4 Saving and Printing Data 
 

(a) Due to software limitations, it is more reliable to save all your data into the software’s 
results database and print a report at the end of the experiment.  To do this, you need to 
create a unique entry in the results database for your experiment.  In the Manual 
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Analysis window (see below), click on the Browse... button beside the Results Data 
Set Name: entry. 

 
 In the resulting dialog box, enter a unique data set name and description for your 

experiment.  The data set name should consist of letters and numbers only; do not include 
spaces or punctuation characters.   When you close the dialog, the data set name should 
appear in the appropriate text box in the Manual Analysis window, and the Save Data 
box should be checked.  If the Print Log box is checked, uncheck it. 

 
è If you use an existing name, your data will be appended to that group’s data!  You only 

need one entry for your experiment on any given day. 
 
 

 
AAWinlab Manual Analysis Window, showing a poor choice 

for the results data set name – choose something unique! 
  
(b) Once your experiment is complete, you will need to create and print a report:  In the File 

menu, select Utilities®Reporter; this will open the WinLab Reporter window. 
 
(c) Select Chronological, Complete from the pull-down menu just under the Design 

heading, then click on the first number button under the Result Names: heading.  This 
will open a dialog within which you can locate and select the name for your data set 
within the results database.  Note that you can choose to sort the entries by either name 
or date; doing the latter makes it very easy to find your data set, as it will now be first in 
the list! 

 
(d) Click on the PreviewReport button.  In the preview window, click on the printer icon 

at the bottom to call up the print dialog and send your results to the printer.  Note that, if 
you want to print only selected pages, you must use the printer icon button at the bottom 
of the window - the Print option in the File menu will only print the entire report. 
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AAWinLab Report Generator dialog box 

 
 

4.5 Shutting Down the Instrument 
 

(a) Aspirate deionised water for a few minutes while the flame is still on in order to clean 
the nebulizer/spray chamber from the last sample.  In the Flame Control window, click 
the flame switch OFF to turn the flame off.   

 
(b) Close the air and acetylene valves at the rear of the instrument.  Next, click on the Flame 

button in the toolbar and bleed the acetylene line by clicking on Bleed in the Flame 
Control window.  Repeat this process until the gauge above the valve at the rear of the 
instrument shows a zero pressure. 

 
(c) Finally close the Flame Control window, and exit the AAWinLab software.  Log off 

from the computer and turn the instrument off.  Check that no one is using the other AA 
instrument; if everyone is finished, close the main valve on the acetylene cylinder in the 
prep room by turning it clockwise. 
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5.  Experiment E1: Sodium in Beverages by Atomic Emission 
 
This experiment is an exercise in method development: although standard methods exist for many 
common analyses, it is often necessary to adjust these for specific samples.  During the lab, you 
will first determine the working linear range for sodium of the flame atomic emission 
spectrophotometer, and estimate the sodium content of a wine sample.  Using this information, 
you will then develop a protocol to accurately determine the sodium content of this sample using 
the method of standard additions.  As a result, this experiment will involve more steps than would 
be required for the routine analysis of similar samples. 
 
Flame AES exploits the characteristic yellow atomic emission lines of sodium to determine the 
concentration of this important element.  Since most drinks (other than tap or mineral water) 
represent complex sample matrices that cause a variety of interference effects in atomic emission 
spectroscopy, the method of standard additions is preferred for the analysis.  In particular, the 
alcohol content of wine affects the viscosity of the sample, which has important implications for 
the efficiency of aspiration and nebulization. 
 
After performing this experiment, you should: 
– Understand how to establish a protocol for standards addition 
– Know how to calculate sample concentrations by standards addition 
– Develop an understanding of atomic emission versus atomic absorption for determination 

of metals 
 

Essential Notes: 
– When performing this experiment, be sure to note any practical observations, such as 

flame colour, in your notebook. 
– Sodium is one of the more sensitive elements with respect to atomic spectroscopy, and it 

is also prone to ionization effects.  Sodium contamination is a serious source of error.  To 
minimize this, you should: 
1. Avoid the use of detergent for cleaning glassware – these often employ sodium salts 
2. Rinse all glassware thoroughly with ultrapure water before use 
3. Transfer all solutions to plastic Nalgene® bottles as soon as they are made – glass 

contains sodium! 
 

Chemicals: 
• 1.000 g/L sodium standard for atomic spectroscopy (as NaNO3 in 4% HNO3) 
• Solid potassium chloride (sodium-free) 

 
Sample(s): 

• A wine sample and a sodium “unknown” are provided.  Bring your own water sample for 
analysis, or use the ones provided.  Check with your demonstrator the week before this 
experiment to find out is appropriate. 
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A.  Instrument setup and solution preparation 
1. Make sure that the AA you will be using is on, and that the software is running.  Click on 

the Tools button on the screen, then Select Method… and choose the “CHM317NA” file. 
Once back on the main screen, select the Parameters screen and check that the Print Results 
box is checked.  You can also click on the Calibration tab to confirm that the expected 
concentrations have been entered. 

 
2. Ionization suppressor solution:  Weigh out sufficient potassium chloride into a 250 mL 

beaker to make 250 mL of a solution containing 1.0 g K+ for each 100 mL of solution (1.0 
%(w/v)).  Dissolve the KCl in ultrapure water, transfer the solution to a 250 mL volumetric 
flask, and dilute to volume.  Once the solution is prepared, transfer it immediately to a 
clean, rinsed, labelled plastic bottle: the solution will leach sodium from the glass if left in 
the flask, and this will adversely affect your results. 

 
è You could just make this solution in the beaker.  However, should you run out and have to 

re-make it, it will be easier to get the same concentration of potassium using a volumetric 
flask. 

 
3. Sodium Stock Solution:  Obtain the 1.000 g/L Na stock solution from the reagent shelf, and 

transfer a small volume (~5 mL) to a small, clean, dry beaker.  Following standard 
operating procedures, accurately prepare 100.0 mL of a 10.00 mg Na/L solution of sodium 
by dilution of the stock with ultrapure deionised water.  Immediately transfer this to a clean, 
rinsed, labelled plastic bottle. 

 
4. Sodium Calibration Solutions:  Prepare a set of sodium calibration solutions, each of which 

contains (when diluted to final volume) 0.10 %(w/v) of K+ as ionization suppressor.  Use 
the 10.00 mg Na/L stock solution prepared in step 3 to make standards containing 0.100, 
0.200, 0.500, and 1.000 mg Na/L by accurately transferring the appropriate volume into 
separate clean, rinsed 100 mL volumetric flasks.  Add 10.00 mL of the 1.0 %(w/v) K+ 
solution to each flask before diluting to volume.  Make sure the solutions are well mixed 
and immediately transfer the solutions to clean, rinsed, labelled plastic bottles. 

 
5. Reagent Blank:  Finally, prepare 100.0 mL of a solution that only contains 0.10 %(w/v) of 

K+ as ionization suppressor (i.e. has no sodium in it).  Again, immediately transfer this to a 
clean, rinsed, labelled plastic bottle once it has been diluted to volume and mixed. 

 
B.  Instrument Performance and Estimate of Sodium Content 

6. Take your solutions through to LM9 to the instrument assigned to you.  Light the flame by 
clicking on the On/Off switch in the Flame Control window.  Make sure that the plastic 
sample tube connected to the nebulizer is immersed in ultrapure deionised water (there 
should be a flask with the instrument), and that the flame is a clear blue colour.  While 
operating the spectrometer, make sure that the instrument is aspirating ultrapure deionised 
water whenever the flame is on and you are not taking readings. 
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è While one of you is calibrating the flame atomic spectrophotometer, another should be 
preparing the samples for analysis.  For each sample, dispense 10.00 mL of the sample and 
10.00 mL of the 1.0 %(w/v) K+ solution into a 100.0 mL volumetric flask and dilute to 
volume with ultrapure deionised water.  Transfer to a clean, labelled Nalgene bottle as soon 
as possible. 

 
7. When operating in flame emission mode, the instrument needs to set the correct gain on 

the detector (a photomultiplier tube) for the range of emission intensities represented by 
your standards and samples.  Once the flame has been on for ~ 5 minutes, select Analyze 
Blank from the main screen. 

 
 You will be asked to aspirate the most concentrated sample or standard; switch the sample 

tube from the ultrapure deionised water to your 1.000 mg Na/L standard (with 0.1%w/v 
K+) and click the OK button. 

 
 Once the instrument has taken a reading, you will be asked to aspirate your blank or lowest 

standard.  Remove the plastic sample tube from your standard, wiping it down with a 
KimWipe™ as you do so, and place it back in the reagent blank (i.e. the solution that 
contains only 0.1%w/v K), then click the OK button.  Once the instrument has taken this 
reading, it will be ready for calibration. 

 
8. You can now start analysing your standards, working from the lowest to highest 

concentration (0.100–1.000 mg Na/L).  Check that the display shows the standard you 
expect. Place the nebuliser tube in your first standard and then click on the “Analyze 
Standard” button.  Once completed, switch back to the deionized water.  The display should 
update to the next standard; repeat until all the standards have been measured.  You can 
check the calibration by pressing the “Display Calibration” button. 

 
è Should you need to repeat any standard measurement, click on the displayed concentration; 

a dialogue should appear allowing you to select the standard you want to measure. 
 

9. Once you have finished calibrating the instrument, you can measure the sodium content of 
your samples.  You can type a short text description into the Sample ID field of the main 
window to identify the sample in the database; you should, however, also be recording all 
the blanks, standards, and samples in your lab notebook as you perform the experiment!  
To take a sample reading, click on the Analyze Sample button; once the instrument has 
finished taking a reading, it will report the calculated concentration and you can return the 
sample tube to the flask of ultrapure deionised. 

 
è If your sample contains more sodium than your highest standard, you will simply get an 

error message; if this occurs, roughly dilute your sample using a measuring cylinder until 
it comes within your calibration range.  For example, wine samples will typically require 
a dilution factor of roughly 1:100 – 1:500. 

 
 Once you have finished all your measurements, turn the flame off and obtain a hard copy 

of your data from the database (see section 4.4, page 6). 
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C.  Determination of Sodium Content by Standard Additions 

10. Now you have first measurement of the sodium content of your samples, as well as the 
linear range for sodium emission, you can determine how to make up your solutions for 
the determination of sodium in the wine sample by standards addition.  Each solution you 
make should: 

• Contain a final concentration of 0.1%w/v K 
• Contain a total sodium concentration that is within your linear range 
• Have total sodium concentrations covering an order of magnitude (factor of 10) 

 
 For example, if the linear range for sodium extended to 5 mg Na/L, and your sample had 

an estimated concentration of 10 mg Na/L, you would want to have a set of solutions with 
total sodium concentrations covering the range 0.2 – 2.0 mg Na/L.  To achieve this, you 
would pipette 2.00 mL of sample into each 100.0 mL flask, along with 10.00 mL of your 
1.0 %w/v K solution.  You would then add 1.00 mL, etc. of your 10.00 mg Na/L standard 
to each successive flask, so that you have one diluted sample and at least four additions.  
The following table shows the resulting added and total concentrations for this particular 
example; create your own table in your lab notebook, using the actual estimate of your own 
sample concentration as the starting point. 

 
Estimated sample concentration: 10 mg Na/L 
Concentration of standard for additions: 10.00 mg/L 

Flask: A 
(Sample) 

B 
(Add. 1) 

C 
(Add. 2) 

D 
(Add. 3) 

E 
(Add. 4) 

Vol. 1% K 
(mL): 

10.00 10.00 10.00 10.00 10.00 

Vol. sample 
(mL): 

2.00     

C sample 
(mg/L) 

0.200     

Vol. std. 
added (mL) 

0     

C added 
(mg/L): 

0     

C total 
(mg/L): 

0.200     

 
11. Once you have checked your scheme with your TA and made your sample solutions, you 

are ready to return to the instrument and perform the analysis.  Click on the Method... 
button and load the method chm317NaAdd (see sections 4.2(a) and 4.3 on pages 4 and 
6), and then light the flame again. 
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12. You will need to tell the software what concentrations you are using for your additions.  
Click on the Parameters button in the main toolbar, then go to the Calibration tab, and.  
This will display a small spreadsheet-like area displaying the expected values of the 
concentration added to the sample. Edit this area with your own concentrations and 
volumes, deleting any rows that you don’t need.   

M You should NOT add a row for an added concentration of zero; this is included (albeit with 
an odd label) in the table already.  If you add a row with a zero concentration into the table, 
your experiment is DOOMED! 

13. Once you are done, you are ready to analyse your wine sample. Click on the Analyse Blank 
button as before; you should be prompted to add the highest concentration solution (the 
one with the greatest amount of added standard).  After this, return to your reagent blank, 
(the solution containing only 0.1 %w/v K).  Continue analysing the additions. When you 
have measured all the solutions that you listed in the method editor, the software will 
extrapolate the graph and calculate the concentration of sodium in your sample. 

D.  Finishing Up 
14. Once you are satisfied with your data, print out the results from your analysis and shutdown 

both the instrument and the software as indicated in sections 4.4 and 4.5.  Make sure you 
collect all your solutions, beakers, etc., and return them to LM6. 

15. Dispose of all your solutions in the proper waste container.  Used Pasteur pipettes should 
be rinsed thoroughly with distilled water before being disposed in the teal-coloured 
decontaminated glass bin.  Clean all your glassware, using some alcohol on a KimWipe™ 
to remove any labels, and return it to the correct bench drawers. 

è Please keep all the transfer and graduated pipettes in a different drawer to the rest of the 
glassware, in order to minimize accidental breakage 

 Check all areas where you have been working – balance, bench, and instrument – to make 
sure that they are clean and tidy, and that all chemicals have been returned to the correct 
shelves.  When done, have your TA validate your lab notebooks before leaving. 

F.  Data Analysis 
16. Use Excel™ to plot the regular calibration data for sodium emission, using the mean blank 

corrected values.  Note that, although the software refers to all readings as ‘absorbance’, in 
emission mode these are intensity values having arbitrary units.  Determine the linear 
region of the calibration data (see the on-line statistics tutorial for details on how to do 
this). 

17. Use the calibration curve to determine the concentration of sodium in both your water 
sample and the “unknown” provided; also calculate and report the uncertainties associated 
with these concentrations.  Remember to take into account any sample dilution required in 
order to place the sample within the linear region of the calibration curve. 

18. Use Excel™ to produce a standards addition calibration plot for your sample data, again 
using the mean blank corrected values provided by the software.  Perform your own linear 
regression analysis on the data, calculating r or r2, sy/x, and the intercept on the concentration 
axis together with its uncertainty (again, the on-line statistics tutorial provides a formula 
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for the value of sxE required.)  Use this to determine the actual sodium concentration of 
your original sample, taking into account the dilution factor inherent in the method of 
standards addition, and completing the corresponding error propagation.  Compare this 
value to your original estimate. 

19. Comment in your report on whether your choice of additions was appropriate for 
determining the sodium content of the wine sample.  What steps might you take to decrease 
the uncertainty in the extrapolated value for the sodium concentration? 
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6.  Experiment E2:  Calcium–Magnesium Water Hardness 
 
This experiment is based on the standard procedures for the flame atomic absorption determination 
of calcium and magnesium described by American Public Health Association in “Standard 
Methods for the Examination of Water and Wastewater”, 20th edition.  The same basic procedures 
are used by water testing laboratories in Canada, Europe, and the US.  In addition to tap and fish 
tank water samples, you should bring in your own sample of bottled water for testing. 
 
Although inductively coupled plasma atomic (optical) emission spectrophotometry is generally 
faster when analysing multiple elements, both the instrumentation cost and operating expenses are 
significantly higher than for flame AAS.  With only two elements of interest and a large number 
of samples, flame AAS is therefore preferred for water hardness measurements.  The method also 
compares favourably in terms of ease-of-use with the more traditional complexometric titrations. 
 
After performing this experiment, you should: 
– Understand how to use dual element lamps for multi-element AAS analysis 
– Develop an appreciation of background correction in flame AAS 

 
Essential Notes: 

– When performing this experiment, be sure to note any practical observations, such 
as flame colour, in your notebook. 

– Make sure you label all containers before use, and keep careful track in your lab 
notebook when dispensing solutions to make the required multi-element standards; 
omitting one of your solutions or using the wrong volume will result in this 
experiment taking far longer than it should! 

 
Chemicals: 

• 100.0 mg/L calcium and magnesium standards for atomic spectroscopy 
(As the metal nitrate in 4% nitric acid) 

• Solid lanthanum trinitrate hexahydrate, La(NO3)3×6H2O (Mm = 433.03 g/mol) 
 

Sample(s): 
• You will be provided with an “unknown” sample, which should be analysed along with 

the tap water in the lab.  You should also bring your own water sample for analysis; 
check with your demonstrator the week before this experiment to find out is appropriate. 

 
1. Open the workspace “CHM317CM”; this will open and position a number of windows for 

you.  Click on the MethodEd button and check that the method “Calcium Water” is 
loaded; if not, click on the Method Editor button and select this method, then click OK. 

    
Open the Lamps window and select the Ca lamp, making sure that the lamp is correctly 
identified as Ca rather than Mg.  The appropriate wavelength and slit width have already 
been set in the method.  Check the actual position of the lamp in the carousel, and double-
check the lamp name to make sure it is the right element.  Allow 15 minutes for the lamp 
to warm up.  Set a unique Results Data Set Name for this experiment (page 6); do not 
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change this once you have created it – use the same data set name for all parts of this 
experiment! 

 
2. Prepare 250.0 mL of a stock solution containing about 5.0%(w/v) La3+ by dissolving 

La(NO3)3×6H2O in ultrapure deionised water, transferring this to a 250.0 mL volumetric 
flask, and making up to the mark with ultrapure deionised water.  (You may weigh out the 
lanthanum salt on a top-pan balance; record the weight used to 2 decimal places in your 
lab notebook.) 

 
è You could just make this solution in the beaker.  However, should you run out and have to 

re-make it, it will be easier to get the same concentration of potassium using a volumetric 
flask. 

 
3. Prepare a set of calibration solutions, each of which should contain both Ca2+, Mg2+, and 

La3+ (a releasing agent) as follows: use a transfer pipette to dispense 20.00 mL of the stock 
La3+ solution into each of five 100.0 mL volumetric flasks.  Using the appropriate transfer 
pipettes, dispense the appropriate volumes of the stock 100.0 mg/L Ca2+ and Mg2+ solutions 
to result in the following concentrations when made up to volume with ultrapure deionised 
water: 

 
 

Flask: A B C D D 
[Ca2+] / mg L–1 0.100 0.500 1.000 5.000 10.000 
[Mg2+] / mg L–1 0.050 0.100 0.500 1.000 5.000 

La3+ / %w/v 1.0 1.0 1.0 1.0 1.0 
 

 Transfer the solutions to clean plastic bottles, being sure to rinse the bottles and caps three 
times with small volumes of the solution before filling them. 

 
è For the lower concentrations, you will find it easier to prepare a 10.00 mg/L standard 

without the lanthanum solution, and then dispense this to make your final standards with 
the added lanthanum. 

 
è Label each bottle and flask clearly as you prepare each solution 
 
4. Additionally, prepare a blank by pipetting 20.00 mL of the stock La3+ solution into a sixth 

100.0 mL volumetric flask, and diluting to the mark with ultrapure deionised water.  Label 
the flask. 

 
è At this point, one of you can start running the standards on the AA while the other prepares 

the samples for analysis – see step 6. 
 
5. To prepare a sample, use a transfer pipette to dispense 10.00 mL of the sample and 20.00 

mL of the stock La3+ solution into a clean 100.0 mL flask, then dilute to the mark with 
ultrapure water.  In this manner, prepare samples of water from the hot and cold taps, fish 
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tank water, and bottled water for analysis.  Also prepare 100.0 mL of a solution containing 
1.00 ppm Ca and 1.00 ppm Mg with no added La, to be run as a sample.  Label these 
clearly! 

 
6. Light the flame on the spectrometer as described in 4.2(c), making sure that the plastic 

sample tube is immersed in the flask of ultrapure deionised water provided.  Open the 
Continuous Graphics window from the Tools menu, and monitor the absorbance 
reading for a few seconds.  When it appears to have stabilised, click on the Autozero 
button; use the Autoscale button to rescale the display, and continue to monitor the 
absorbance a little longer.  If it appears to be stable (i.e. not drifting), Autozero one last 
time and close the Continuous Graphics window. 

 
7. Select Method Editor from the Tools menu or click on the MethodEd button, and 

confirm the following settings in the resulting tabbed dialog (see below.) In particular, 
check the values of the standard concentrations listed in the Calib tab under Standard 
Concs: these should match the concentrations set out in the table above.  Once satisfied, 
close the method window. 

 

 
The method editor window 

 
8. Aspirate the reagent blank solution (i.e. the one containing only the dilute lanthanum), and 

click on the Analyse Blank button in the Manual Analysis window (below).  Once the 
software has finished collecting the data (the current status will read ‘Idle’), switch to the 
lowest concentration standard.  Check that the window displays “Standard 1” and click on 
the Analyse Standard button.  Once the software has finished collecting the data, the 
display should update to “Standard 2”, and the calibration curve in the graphics window 
should also update.  Continue in this manner until you have analysed all the standards in 
sequence from lowest to highest. 

 
9. Now analyse each sample in turn: you may click in the Sample ID: field to give each 

sample a name, which will appear on the resulting print–out.  Enter the sample ID 
information, aspirate the sample, and click on the Analyse Sample button.   
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è Do not change the results data set name – only change the Sample ID: field! 
 

 
The manual analysis window 

 
10. Once the analysis for calcium is completed, click on the Method... button and load the 

method chm317MgWater (“Magnesium in Water”).  Click on the Lamps button and 
change the entry for the calcium lamp from Ca to Mg.  Since the lamp is a dual-element 
lamp, it does not need to warm up before you continue with your measurements. 

 
11. Repeat the analysis procedure (including the reagent blank), but this time analysing for 

magnesium instead of calcium.  Once you have finished running all the standards and 
samples, check how much time you have left.  If there is sufficient time available, click on 
the Method... button again, but this time load the method chm317MgWaterBG 
(“Magnesium in Water BGC”).  This will enable the deuterium lamp background 
correction system for the method. 

 
Click on the Lamps button, turn on the deuterium lamp using the button in Lamps 
window, and allow it to warm up for ~ 5 minutes before continuing.  Repeat your analysis 
(autozero on deionised water, reagent blank, standards, and samples) for magnesium but 
this time with background correction on. 

 
D.  Finishing Up 

 
12. Once you are satisfied with your data, print out the results from your analysis and shutdown 

both the instrument and the software as indicated in sections 4.4 and 4.5.  Make sure you 
collect all your solutions, beakers, etc., and return them to LM6. 

 
13. Dispose of all your solutions in the proper waste container.  Used Pasteur pipettes should 

be rinsed thoroughly with distilled water before being disposed in the teal-coloured 
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decontaminated glass bin.  Clean all your glassware, using some alcohol on a KimWipe™ 
to remove any labels, and return it to the correct bench drawers. 

 
è Please keep all the transfer and graduated pipettes in a different drawer to the rest of the 

glassware, in order to minimize accidental breakage 
 
 Check all areas where you have been working – balance, bench, and instrument – to make 

sure that they are clean and tidy, and that all chemicals have been returned to the correct 
shelves.  When done, have your TA validate your lab notebooks before leaving. 

 
 E.  Analysis of the data 

 
14. Reconstruct the calibration curves for Ca, Mg, and Mg with background correction (if 

completed) using the blank corrected absorbance values reported by the software.  
Determine the linear portion of each graph, and find the best-fit straight line through the 
linear region by linear regression analysis.  Calculate r or r2, sy/x, and the limits of detection 
and quantitation for the linear portion of each calibration curve. 

 
è The on-line statistics tutorial has a section on how to find the linear region using Excel™.  

See http://www.chem.utoronto.ca/coursenotes/analsci/stats/ 
 
15. Use your calibration curves to determine the individual concentrations of Ca and Mg in 

your samples, as well as for the solution of calcium and magnesium prepared without the 
added lanthanum.  Also use the linear regions of each calibration curve to determine the 
flame AAS sensitivity for calcium, magnesium, and magnesium with background 
correction enabled. 

 
16. If you were able to obtain data for magnesium both with and without background 

correction, compare both the absorbance and concentration values you obtained by both 
methods.  Determine what difference, if any, there were in both the blank-subtracted 
absorbance values and the corresponding sample concentrations obtained for your samples.   
Also compare the limits-of-detection and sensitivity that were obtained with and without 
background correction. 
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7.  Elements for Report Discussion 
 

Your formal report for this technique should describe the experiments performed and present the 
results obtained, commenting on any special features of the methodology and instrumentation 
used.  From the results, you should go on to discuss the factors that both atomic absorption and 
emission, and such factors can be mitigated. Some (but not all) of the topics you should address 
include: 

 
1. In the lab, you used air-acetylene flames as the atom source.  What are the advantages and 

disadvantages associated with using an inductively coupled plasma source instead, and 
which is most appropriate for (a) atomic emission and (b) atomic absorption? 

 
2. Calcium and magnesium are known to form refractory compounds with phosphate, a 

common interferent in water samples.  Lanthanum is commonly added as a releasing agent, 
however it can also have another effect.  Using your results from experiment E2 for the 
Ca+Mg sample with no added La3+ or phosphate, explain what this role is. 

 
3. Atomic absorption lines are much narrower than the features seen in molecular absorption, 

yet we still require a monochromator in flame atomic spectroscopy.  Why is this, and where 
is it located in the instrument? 

 
4. How does sensitivity compare between flame AAS, flame AES, and ICP-AES?  What 

factors would you need to take into account in choosing one technique over another for any 
given analysis? 

 
 


